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7. The Text Import Wizard will appear: 
 

A. Step 1: Select “Delimited” to describe 
data, then click “Next”. 

 
B. Step 2: Click “Next”. 

C. Step 3: Verify that the first column of 
data is highlighted (if not, click to 
highlight it), then hold down the Shift 
key as you scroll to the right and click 
on the last column.  All columns now 
should be highlighted.  Under Column 
Data Format, select “Text” to ensure that all columns 
in the file are in the correct format. 

 
i. If you receive a message that the file did not load 

completely, this indicates that the file includes 
more than 65,536 part numbers and exceeds 
Excel’s row limitations.  To address this problem, 
click “OK” and continue to Step 8. 

ii. If you receive a message that the file loaded 
completely, click “Finish” and skip to Step 13. 

 
8. From the File menu, select “Save As”.  Navigate to the target location to save the file.  Utilize the 

default file name or type the desired name in the File Name field.  Use the Save As Type drop-down 
menu to select “Microsoft Excel Workbook”.  Click “Save”.  From the File menu, select “Close”, or 
click the X in the upper-right corner to close the file but leave Excel open.   

 
9. Repeat Step 6. 
 
10. The Text Import Wizard will appear: 
 

A. Step 1: Select “Delimited” to describe data.  Set 
“Start Import at Row” equal to 32000.  Click 
“Next”. 

B. Step 2: Click “Next”. 

C. Step 3: Repeat Step 7C. 

D. Click “Finish”. 
 
11. Repeat Step 8. 
 
12. From the File menu, select “Open”.  Navigate to the first file you created and double-click, or 

highlight the file and click “Open”.  Scroll down to row 32,000 and click on the row number to 
highlight the entire row.  Holding down the Shift key, scroll down to the last row (should be 65,536) 
and click on the row number to highlight all rows from 32,000 to 65,536.  Delete highlighted rows by 
right-clicking and selecting “Delete”, or from the Edit menu, select “Delete…”, then “Delete Entire 
Row”.  Repeat Step 8.   

 
13. Close Excel.  
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PRODUCT & PRICE INFORMATION FORMAT 
Converting PPIF Data to Microsoft® Access  
 
 
While product and pricing information must be provided in ASCII, tab-delimited format to be compliant 
with the Product & Price Information Format (PPIF), many distributors prefer to convert this information 
to Microsoft® Access for uploading to a distributor management system or for direct reference.  
 
The following procedures outline a suggested process to convert PPIF-compliant data into a new Access 
database in a Windows environment.  This process may vary slightly based on the version of Access used 
or other variables; for additional assistance, consult your vendor’s PPIF contact.   
 
1. For files transmitted by:  
 

A. CD-ROM or other electronic storage devise:  Insert storage media into computer. 

B. E-mail or Internet-based file transfer:  Save file to desired destination on a hard drive or network 
server.   

 
2. Open Windows Explorer by right-clicking on the Start button on the Windows Taskbar.   
 
3. Navigate to the drive that holds the storage media or to where the file was saved and double-click on 

the drive name (e.g., “A:”, “D:” or “E:”).   
 
4. Extract the files: 
 

A. If the files are not compressed: Skip to Step 5. 

B. If the files are compressed and self-extracting: Follow vendor instructions to extract.   

C. If the files are compressed using WinZip: 
 

i. Launch the WinZip Extractor by double-clicking on the file name or icon in Windows 
Explorer or right-click on the file and select WinZip, then “Extract to …”. 

ii. If prompted with a warning message that the file is intended to be used under Windows 95 or 
newer, click “Yes” (assuming your computer is running an acceptable version of Windows).  
For systems running an older version of Windows, file extraction may need to be done by 
someone who has the required software.  

iii. In the WinZip Extractor, navigate to the target destination to save the file, then click 
“Extract”. 

iv. If prompted with a message that indicates that the files have been successfully unzipped, click 
“Yes” to confirm, then “Close”. 

 
5. Launch Microsoft Access.  
 
6. From the File menu, select New.  Create a new Access database by selecting “Blank Database” from 

the list on the right.   
 
7. The File New Database window will appear.  Assign a name to your database and click “Create”.  
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8. Navigate to the directory to which files were extracted.  Set “Files of Type” to “Text Files”.  Find the 
appropriate file and double-click, or highlight the file name and click “Import”. 

 
9. The Import Text Wizard will appear: 
 

A. Step 1: Select “Delimited” to describe 
data, then click “Next”. 

B. Step 2: Verify that delimiter is set to 
“Tab”, then click “Next”. 

C. Step 3: When prompted where to store 
data, select “In a New Table”, then click 
“Next”. 

D. Step 4: Click “Next”. 
E. Step 5: Click “Next”. 
F. Step 7: Click “Finish”. 

 
10. Save your Access database and close 

Access.  
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PRODUCT & PRICE INFORMATION FORMAT 
Suggested Currency Codes 
ISO 3-Letter Alphabetic Currency Codes 
Updated as of 10.23.08 

ISO 4217 
 
The following table reproduces ISO 4217.  Please use only codes that have been accepted into 
this standard.  An asterisk indicates no currency code has been assigned to that country/entity.  
For the most current list, please visit 
http://www.iso.org/iso/support/faqs/faqs_widely_used_standards/widely_used_standards_other/ 
currency_codes/currency_codes_list-1.htm. 
 
Code Country/Entity Code Country/Entity 
AFN Afghanistan CVE Cape Verde 
ALL Albania KYD Cayman Islands 
DZD Algeria XAF Central African Republic 
USD American Samoa XAF Chad 
EUR Andorra CLP/CLF Chile 
AOA Angola CNY China 
XCD Anguilla AUD Christmas Island 
* Antarctica AUD Cocos (Keeling) Islands 
XCD Antigua and Barbuda COP/COU Colombia 
ARS Argentina KMF Comoros 
AMD Armenia XAF Congo 
AWG Aruba CDF Congo, Democratic Rep. of the 
AUD Australia NZD Cook Islands 
EUR Austria CRC Costa Rica 
AZN Azerbaijan XOF Côte D'ivoire 
BSD Bahamas HRK Croatia 
BHD Bahrain CUP Cuba 
BDT Bangladesh EUR Cyprus 
BBD Barbados CZK Czech Republic 
BYR Belarus DKK Denmark 
EUR Belgium DJF Djibouti 
BZD Belize XCD Dominica 
XOF Benin DOP Dominican Republic 
BMD Bermuda USD Ecuador 
INR/BTN Bhutan EGP Egypt 
BOB/BOV Bolivia SVC/USD El Salvador 
BAM Bosnia and Herzegovina XAF Equatorial Guinea 
BWP Botswana ERN Eritrea 
NOK Bouvet Island EEK Estonia 
BRL Brazil ETB Ethiopia 
USD  British Indian Ocean Territory FKP Falkland Islands(Malvinas) 
BND Brunei Darussalam DKK Faroe Islands 
BGN Bulgaria FJD Fiji 
XOF Burkina Faso EUR Finland 
BIF Burundi EUR France 
KHR Cambodia EUR French Guiana 
XAF Cameroon XPF French Polynesia 
CAD Canada EUR French Southern Territories 
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Suggested Currency Codes—CONTINUED 
ISO 3-Letter Alphabetic Currency Codes 

ISO 4217 
 
XAF Gabon LVL Latvia 
GMD Gambia LBP Lebanon 
GEL Georgia ZAR/LSL Lesotho 
EUR Germany LRD Liberia 
GHS Ghana LYD Libyan Arab Jamahiriya 
GIP Gibraltar CHF Liechtenstein 
EUR Greece LTL Lithuania 
DKK Greenland EUR Luxembourg 
XCD Grenada MOP Macao 
EUR Guadeloupe MKD Macedonia, the Former Yugoslav 

Republic of 
USD Guam MGA Madagascar 
GTQ Guatemala MWK Malawi 
GNF Guinea MYR Malaysia 
GWP/XOF Guinea-Bissau MVR Maldives 
GYD Guyana XOF Mali 
HTG/USD Haiti EUR Malta 
AUD  Heard Island and Mcdonald 

Islands 
USD Marshall Islands 

EUR Holy See (Vatican City State) EUR Martinique 
HNL Honduras MRO Mauritania 
HKD Hong Kong MUR Mauritius 
HUF Hungary EUR Mayotte 
ISK Iceland MXN/MXV Mexico 
INR India USD Micronesia, Federated States of 
IDR Indonesia MDL Moldova, Republic of 
XDR International Monetary Fund 

(I.M.F.) 
EUR Monaco 

IRR Iran (Islamic Republic of) MNT Mongolia 
IQD Iraq EUR Montenegro 
EUR Ireland XCD Montserrat 
ILS Israel MAD Morocco 
EUR Italy MZM Mozambique 
JMD Jamaica MMK Myanmar 
JPY Japan ZAR/NAD Namibia 
JOD Jordan AUD Nauru 
KZT Kazakhstan NPR  Nepal 
KES Kenya NLG Netherlands 
AUD Kiribati ANG Netherlands Antilles 
KPW Korea, Democratic People's 

Rep. of 
XPF New Caledonia 

KRW Korea, Republic of NZD New Zealand 
KWD Kuwait NIO Nicaragua 
KGS Kyrgyzstan XOF Niger 
LAK Lao People's Democratic 

Republic 
NGN Nigeria 
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Suggested Currency Codes—CONTINUED 
ISO 3-Letter Alphabetic Currency Codes 

ISO 4217 
 
NZD Niue LKR Sri Lanka 
AUD Norfolk Island SDG Sudan 
USD Northern Mariana Islands SRD Suriname 
NOK Norway NOK Svalbard and Jan Mayen 
OMR Oman SZL Swaziland 
PKR Pakistan SEK Sweden 
USD Palau CHF/CHW/CHE Switzerland 
PAB/USD Panama SYP Syrian Arab Republic 
PGK Papua New Guinea TWD Taiwan, Province of China 
PYG Paraguay TJS Tajikistan 
PEN Peru TZS Tanzania, United Rep. of 
PHP Philippines THB Thailand 
NZD Pitcairn USD Timor-Leste 
PLN Poland XOF Togo 
EUR Portugal NZD Tokelau 
USD Puerto Rico TOP Tonga 
QAR Qatar TTD Trinidad and Tobago 
EUR Reunion TND Tunisia 
RON Romania TRL Turkey 
RUB Russian Federation TMM Turkmenistan 
RWF Rwanda USD Turks and Caicos Islands 
SHP Saint Helena AUD Tuvalu 
XCD Saint Kitts and Nevis UGX Uganda 
XCD Saint Lucia UAH Ukraine 
EUR Saint Pierre and Miquelon AED United Arab Emirates 
XCD Saint Vincent and The 

Grenadines 
GBP United Kingdom 

WST Samoa USD/USS/USN United States 
EUR San Marino USD United States Minor:  

Outlaying Islands 
STD Sao Tome and Principe UYU/UYI Uruguay 
SAR Saudi Arabia UZS Uzbekistan 
XOF Senegal VUV Vanuatu 
RSD Serbia VEF Venezuela 
SCR Seychelles VND Viet Nam 
SLL Sierra Leone USD Virgin Islands, British 
SGD Singapore USD Virgin Islands, U.S. 
EUR Slovakia XPF Wallis and Futuna  
EUR Slovenia MAD Western Sahara 
SBD Solomon Islands YER Yemen 
SOS Somalia ZMK Zambia 
ZAR South Africa ZWD Zimbabwe 
EUR Spain   
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PRODUCT & PRICE INFORMATION FORMAT 
Suggested Unit of Measure Codes 
 
Data Element Dictionary Table 355 
ANSI ASC.X12 
 
The following reflects common units of measurement for use in Product & Price Information Format 
(PPIF) Standard Format Record Field 19 (Selling Unit of Measure) and Field 22 (Unit of Weight).  Codes 
shown below reflect a subset of the full ANSI ASC X12 – 355; the complete table is available at 
www.x12.org.  Only codes accepted into the EDI standard should be used.   
 
Additional codes may be added at any time.  Other code use should be reported to PTDA 
(+1.312.516.2100; ptda@ptda.org) or BSA (+1.630.858.3838; info@bsahome.org) so that additional 
codes may be added to this table. 
 
Code Explanation Code Explanation Code Explanation 
AY Assembly FT Foot ML Milliliter 
NB Barge P4 Four Pack MM Millimeter 
BT  Belt GA Gallons P9 Nine Pack 
BX Box GR Gram PR Pair 
NC Car HU Hundred PL Pallet/Unit Load 
C4 Car Load HB Hundred Boxes LB Pound 
CG Card HC Hundred Count LA Pounds per Cubic Inch 
CT Carton HF Hundred Feet P2 Pounds per Foot 
CA Case KK Hundred Kilograms NS Short Ton (2000 lbs) 
CM Centimeter GI Imperial Gallon P6 Six Pack 
CH Container IN  Inches SV Skid 
CP Crate KE Keg SL Sleeve 
CC Cubic Centimeter KG Kilogram SO Spool 
CF Cubic Feet LF  Linear Foot SF Square Foot 
CI Cubic Inches LY Linear Yard SI Square Inch 
CL Cylinder LK Link TK Tank 
DZ Dozen LT Liters TH Thousand 
DP Dozen Pair NL Load P3 Three Pack 
DR Drum AM Machine Unit NT Trailer 
EA  Each MR Meter TC Truck Load 
P8 Eight Pack ME Milligram TB Tube 
FO Fluid Ounce   OP Two Pack 
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PRODUCT & PRICE INFORMATION FORMAT 
Suggested Country of Origin Codes 
 
The following reflects country of origin codes as defined by ISO 3166-1 for use in Product & Price 
Information Format (PPIF) Standard Format Record Fields 64-68 (Country of Origin).   
 
Additional codes may be added at any time.  Other code use should be reported to PTDA 
(+1.312.516.2100; ptda@ptda.org) or BSA (+1.630.858.3838; info@bsahome.org) so that additional 
codes may be added to this table. 
 
Country Name ISO 3166-1-alpha-2 

Code 
AFGHANISTAN AF 
ÅLAND ISLANDS AX 
ALBANIA AL 
ALGERIA DZ 
AMERICAN SAMOA AS 
ANDORRA AD 
ANGOLA AO 
ANGUILLA AI 
ANTARCTICA AQ 
ANTIGUA AND 
BARBUDA 

AG 

ARGENTINA AR 
ARMENIA AM 
ARUBA AW 
AUSTRALIA AU 
AUSTRIA AT 
AZERBAIJAN AZ 
BAHAMAS BS 
BAHRAIN BH 
BANGLADESH BD 
BARBADOS BB 
BELARUS BY 
BELGIUM BE 
BELIZE BZ 
BENIN BJ 
BERMUDA BM 
BHUTAN BT 
BOLIVIA, 
PLURINATIONAL STATE 
OF 

BO 

BOSNIA AND 
HERZEGOVINA 

BA 

BOTSWANA BW 
BOUVET ISLAND BV 
BRAZIL BR 
BRITISH INDIAN OCEAN 
TERRITORY 

IO 

BRUNEI DARUSSALAM BN 
BULGARIA BG 
BURKINA FASO BF 
BURUNDI BI 
CAMBODIA KH 
CAMEROON CM 
CANADA CA 

Country Name ISO 3166-1-alpha-2 
Code 

CAPE VERDE CV 
CAYMAN ISLANDS KY 
CENTRAL AFRICAN 
REPUBLIC 

CF 

CHAD TD 
CHILE CL 
CHINA CN 
CHRISTMAS ISLAND CX 
COCOS (KEELING) 
ISLANDS 

CC 

COLOMBIA CO 
COMOROS KM 
CONGO CG 
CONGO, THE 
DEMOCRATIC 
REPUBLIC OF THE 

CD 

COOK ISLANDS CK 
COSTA RICA CR 
CÔTE D'IVOIRE CI 
CROATIA HR 
CUBA CU 
CYPRUS CY 
CZECH REPUBLIC CZ 
DENMARK DK 
DJIBOUTI DJ 
DOMINICA DM 
DOMINICAN REPUBLIC DO 
ECUADOR EC 
EGYPT EG 
EL SALVADOR SV 
EQUATORIAL GUINEA GQ 
ERITREA ER 
ESTONIA EE 
ETHIOPIA ET 
FALKLAND ISLANDS 
(MALVINAS) 

FK 

FAROE ISLANDS FO 
FIJI FJ 
FINLAND FI 
FRANCE FR 
FRENCH GUIANA GF 
FRENCH POLYNESIA PF 
FRENCH SOUTHERN 
TERRITORIES 

TF 
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Country Name ISO 3166-1-alpha-2 
Code 

GABON GA 
GAMBIA GM 
GEORGIA GE 
GERMANY DE 
GHANA GH 
GIBRALTAR GI 
GREECE GR 
GREENLAND GL 
GRENADA GD 
GUADELOUPE GP 
GUAM GU 
GUATEMALA GT 
GUERNSEY GG 
GUINEA GN 
GUINEA-BISSAU GW 
GUYANA GY 
HAITI HT 
HEARD ISLAND AND 
MCDONALD ISLANDS 

HM 

HOLY SEE (VATICAN 
CITY STATE) 

VA 

HONDURAS HN 
HONG KONG HK 
HUNGARY HU 
ICELAND IS 
INDIA IN 
INDONESIA ID 
IRAN, ISLAMIC 
REPUBLIC OF 

IR 

IRAQ IQ 
IRELAND IE 
ISLE OF MAN IM 
ISRAEL IL 
ITALY IT 
JAMAICA JM 
JAPAN JP 
JERSEY JE 
JORDAN JO 
KAZAKHSTAN KZ 
KENYA KE 
KIRIBATI KI 
KOREA, DEMOCRATIC 
PEOPLE'S REPUBLIC OF 

KP 

KOREA, REPUBLIC OF KR 
KUWAIT KW 
KYRGYZSTAN KG 
LAO PEOPLE'S 
DEMOCRATIC 
REPUBLIC 

LA 

LATVIA LV 
LEBANON LB 
LESOTHO LS 
LIBERIA LR 
LIBYAN ARAB 
JAMAHIRIYA 

LY 

Country Name ISO 3166-1-alpha-2 
Code 

LIECHTENSTEIN LI 
LITHUANIA LT 
LUXEMBOURG LU 
MACAO MO 
MACEDONIA, THE 
FORMER YUGOSLAV 
REPUBLIC OF 

MK 

MADAGASCAR MG 
MALAWI MW 
MALAYSIA MY 
MALDIVES MV 
MALI ML 
MALTA MT 
MARSHALL ISLANDS MH 
MARTINIQUE MQ 
MAURITANIA MR 
MAURITIUS MU 
MAYOTTE YT 
MEXICO MX 
MICRONESIA, 
FEDERATED STATES OF 

FM 

MOLDOVA, REPUBLIC 
OF 

MD 

MONACO MC 
MONGOLIA MN 
MONTENEGRO ME 
MONTSERRAT MS 
MOROCCO MA 
MOZAMBIQUE MZ 
MYANMAR MM 
NAMIBIA NA 
NAURU NR 
NEPAL NP 
NETHERLANDS NL 
NETHERLANDS 
ANTILLES 

AN 

NEW CALEDONIA NC 
NEW ZEALAND NZ 
NICARAGUA NI 
NIGER NE 
NIGERIA NG 
NIUE NU 
NORFOLK ISLAND NF 
NORTHERN MARIANA 
ISLANDS 

MP 

NORWAY NO 
OMAN OM 
PAKISTAN PK 
PALAU PW 
PALESTINIAN 
TERRITORY, OCCUPIED 

PS 

PANAMA PA 
PAPUA NEW GUINEA PG 
PARAGUAY PY 
PERU PE 
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Country Name ISO 3166-1-alpha-2 
Code 

PHILIPPINES PH 
PITCAIRN PN 
POLAND PL 
PORTUGAL PT 
PUERTO RICO PR 
QATAR QA 
RÉUNION RE 
ROMANIA RO 
RUSSIAN FEDERATION RU 
RWANDA RW 
SAINT BARTHÉLEMY BL 
SAINT HELENA SH 
SAINT KITTS AND 
NEVIS 

KN 

SAINT LUCIA LC 
SAINT MARTIN MF 
SAINT PIERRE AND 
MIQUELON 

PM 

SAINT VINCENT AND 
THE GRENADINES 

VC 

SAMOA WS 
SAN MARINO SM 
SAO TOME AND 
PRINCIPE 

ST 

SAUDI ARABIA SA 
SENEGAL SN 
SERBIA RS 
SEYCHELLES SC 
SIERRA LEONE SL 
SINGAPORE SG 
SLOVAKIA SK 
SLOVENIA SI 
SOLOMON ISLANDS SB 
SOMALIA SO 
SOUTH AFRICA ZA 
SOUTH GEORGIA AND 
THE SOUTH SANDWICH 
ISLANDS 

GS 

SPAIN ES 
SRI LANKA LK 
SUDAN SD 
SURINAME SR 
SVALBARD AND JAN 
MAYEN 

SJ 

SWAZILAND SZ 
SWEDEN SE 

Country Name ISO 3166-1-alpha-2 
Code 

SWITZERLAND CH 
SYRIAN ARAB 
REPUBLIC 

SY 

TAIWAN, PROVINCE OF 
CHINA 

TW 

TAJIKISTAN TJ 
TANZANIA, UNITED 
REPUBLIC OF 

TZ 

THAILAND TH 
TIMOR-LESTE TL 
TOGO TG 
TOKELAU TK 
TONGA TO 
TRINIDAD AND 
TOBAGO 

TT 

TUNISIA TN 
TURKEY TR 
TURKMENISTAN TM 
TURKS AND CAICOS 
ISLANDS 

TC 

TUVALU TV 
UGANDA UG 
UKRAINE UA 
UNITED ARAB 
EMIRATES 

AE 

UNITED KINGDOM GB 
UNITED STATES US 
UNITED STATES MINOR 
OUTLYING ISLANDS 

UM 

URUGUAY UY 
UZBEKISTAN UZ 
VANUATU VU 
VENEZUELA, 
BOLIVARIAN REPUBLIC 
OF 

VE 

VIET NAM VN 
VIRGIN ISLANDS, 
BRITISH 

VG 

VIRGIN ISLANDS, U.S. VI 
WALLIS AND FUTUNA WF 
WESTERN SAHARA EH 
YEMEN YE 
ZAMBIA ZM 
ZIMBABWE ZW 
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PRODUCT & PRICE INFORMATION FORMAT  
Examples of Acceptable Field Use Overview 
 
 
To help simplify implementation of the Product & Price Information Format (PPIF) for first-time users, 
examples of acceptable Standard Product Information Database Record field use have been developed for 
two fictitious companies. 
 
Example records are contained in two files: 
 
• PPIF Examples_Index.xls provides acceptable examples of how specific fields may be populated.  To 

assist users in finding desired examples, indexes are provided by Field Number and description as 
separate worksheets in the same workbook. 

• PPIF Examples_Formatted.txt provides sample PPIF-compliant files for both companies. 
 
Examples for the fictitious companies mimic actual experience, where some companies are able to extract 
and export more comprehensive data from their systems than others.  To mimic typical updates, OEM, 
jobber/reseller and end user pricing are not always provided for example fields.   
 
For additional questions about acceptable and unacceptable field use, contact PTDA (+1.312.516.2100; 
ptda@ptda.org) or BSA (+1.630.858.3838; info@bsahome.org) or a member of the PPIF Technical Task 
Force. 
 
 
GCJ Corp. (Examples 1 through 28) 
 
GCJ Corp. represents a bearing company that manufactures product under three brand names: GBH, 
Jones and Canton.  GCJ Corp. has several product groups and discount codes to show how this 
information should be presented in a PPIF-compliant update.  GCJ Corp. provides information for most 
fields. 
 
A cross-section of examples is provided for 28 items, including examples of acceptable notation for 
replacement/substitute products and multiple packaging options.   For replaced catalog/item numbers and 
UPC numbers, a record also is included for the referenced replacement item.  For items that indicate other 
packaging options are available, a record for these related products also is provided. 
 
 
SFZ Inc. (Examples 29 through 38) 
 
SFZ Inc. represents a power transmission company that produces several types of products, all under the 
SFZ brand.  SFZ Inc. has its own internal part number, which is stored in Field 2 (Catalog or Item 
Number); Field 17 shows the standard catalog designation with the description.  SFZ Inc. provides 
information for a more limited number of fields than GCJ Corp. 
 
Examples 29 through 38 show replacements, new items, UPC changes and catalog/item number changes.  
As with GCJ Corp., product groups and discount codes are included: Different examples include list 
prices and multipliers, net prices, and list and discount prices. 
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PRODUCT & PRICE INFORMATION FORMAT 
Examples of Acceptable Field Use: Index by Field Number

Fields Example Description
12 Standard Record
17 Standard Record
19 Standard Record
25 Standard Record
26 Standard Record
27 Standard Record
28 Standard Record

4, 5 1 Special Invoice Price Multiplier / Special Net Invoice Price
4, 5 2 Special Invoice Price Multiplier / Special Net Invoice Price
4, 5 3 Special Invoice Price Multiplier / Special Net Invoice Price
4, 5 4 Special Invoice Price Multiplier / Special Net Invoice Price
4, 5 5 Special Invoice Price Multiplier / Special Net Invoice Price
4, 5 21 Special Invoice Price Multiplier / Special Net Invoice Price
4, 5 22 Special Invoice Price Multiplier / Special Net Invoice Price
4, 5 23 Special Invoice Price Multiplier / Special Net Invoice Price
4, 5, 20 24 Special Invoice Price Multiplier / Special Net Invoice Price / Units in Package 
5, 7, 9 29 Net Pricing Only
5, 7, 9 30 Net Pricing Only
5, 7, 9 31 Net Pricing Only
10 3 Rebate Amount
10 4 Rebate Amount
20 2 Units In Package
20 4 Units In Package
20 5 Units In Package
24, 25 7 Non-Stock / Non-Returnable
24, 25 13 Non-Stock / Returnable
24, 25 14 Non-Stock / Non-Returnable
24, 25, 60 16 Non-Stock / Minimum Order Qty
26, 24, 25 9 Obsolete Item / Non-Returnable (No Prices)
26, 24, 25 10 Obsolete Item / Non-Returnable (No Prices) 
26, 24, 25 15 Obsolete / Non-Returnable
26, 24, 25, 27, 28 29 Replaced Item / Returnable / New Item / New UPC 
26, 24, 25, 27, 28 30 Replaced Item / Returnable / New Item / New UPC 
26, 24, 25, 27, 28 31 Replaced Item / Returnable / New Item / New UPC 
26, 25 6 Obsolete Item / Returnable
26, 25 11 Obsolete Item / Returnable
26, 27 36 Item Nomenclature Change
26, 27, 28 32 New Item / Superseded Item / Superseded UPC
26, 27, 28 33 New Item / Superseded Item / Superseded UPC
26, 27, 28 34 New Item / Superseded Item / Superseded UPC
26, 28 35 UPC Change
27, 28 6 New Item / New UPC
27, 28 10 New Item / New UPC
27, 28 11 New Item / New UPC
27, 28 15 New Item / New UPC
30, 31 1 Substitute Item / Substitute UPC
30, 31 18 Substitute Item / Substitute UPC
36 8 Special Price Flag
38 1 Next Higher Package
38 3 Next Higher Package
38 4 Next Higher Package
60 7 Minimum Order Quantity
61 13 POR Flag
61 14 POR Flag
62, 63 ,36 8 Conditional Price Multiplier / Conditional Invoice Price / Special Price Flag
62, 63, 36 20 Conditional Price Multiplier / Conditional Invoice Price / Special Price Flag
64-68 32 Country of Origin ISO Code
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PRODUCT & PRICE INFORMATION FORMAT 
Examples of Acceptable Field Use: Index by Description

Description Fields Example
Conditional Price Multiplier / Conditional Invoice Price / Special Price Flag 62, 63 ,36 8
Conditional Price Multiplier / Conditional Invoice Price / Special Price Flag 62, 63, 36 20
Country of Origin ISO Code 64-68 32
Item Nomenclature Change 26, 27 36
Minimum Order Quantity 60 7
Net Pricing Only 5, 7, 9 29
Net Pricing Only 5, 7, 9 30
Net Pricing Only 5, 7, 9 31
New Item / New UPC 27, 28 6
New Item / New UPC 27, 28 10
New Item / New UPC 27, 28 11
New Item / New UPC 27, 28 15
New Item / Superseded Item / Superseded UPC 26, 27, 28 32
New Item / Superseded Item / Superseded UPC 26, 27, 28 33
New Item / Superseded Item / Superseded UPC 26, 27, 28 34
Next Higher Package 38 1
Next Higher Package 38 3
Next Higher Package 38 4
Non-Stock / Minimum Order Qty 24, 25, 60 16
Non-Stock / Non-Returnable 24, 25 7
Non-Stock / Non-Returnable 24, 25 14
Non-Stock / Returnable 24, 25 13
Obsolete / Non-Returnable 26, 24, 25 15
Obsolete Item / Non-Returnable (No Prices) 26, 24, 25 9
Obsolete Item / Non-Returnable (No Prices) 26, 24, 25 10
Obsolete Item / Returnable 26, 25 6
Obsolete Item / Returnable 26, 25 11
POR Flag 61 13
POR Flag 61 14
Rebate Amount 10 3
Rebate Amount 10 4
Replaced Item / Returnable / New Item / New UPC 26, 24, 25, 27, 28 29
Replaced Item / Returnable / New Item / New UPC 26, 24, 25, 27, 28 30
Replaced Item / Returnable / New Item / New UPC 26, 24, 25, 27, 28 31
Special Invoice Price Multiplier / Special Net Invoice Price 4, 5 1
Special Invoice Price Multiplier / Special Net Invoice Price 4, 5 2
Special Invoice Price Multiplier / Special Net Invoice Price 4, 5 3
Special Invoice Price Multiplier / Special Net Invoice Price 4, 5 4
Special Invoice Price Multiplier / Special Net Invoice Price 4, 5 5
Special Invoice Price Multiplier / Special Net Invoice Price 4, 5 21
Special Invoice Price Multiplier / Special Net Invoice Price 4, 5 22
Special Invoice Price Multiplier / Special Net Invoice Price 4, 5 23
Special Invoice Price Multiplier / Special Net Invoice Price / Units in Package 4, 5, 20 24
Special Price Flag 36 8
Standard Record 12
Standard Record 17
Standard Record 19
Standard Record 25
Standard Record 26
Standard Record 27
Standard Record 28
Substitute Item / Substitute UPC 30, 31 1
Substitute Item / Substitute UPC 30, 31 18
Units In Package 20 2
Units In Package 20 4
Units In Package 20 5
UPC Change 26, 28 35
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PRODUCT & PRICE INFORMATION FORMAT 
Examples of Acceptable Field Use: Standard Product Information Database Records

1 2 3 4 5
Example UPC Number Catalog or Item Number Published List Price Special Invoice Price Multiplier Special Net Invoice Price

1 123456789012 6203-2RS/C3 10.00 0.455 4.550
2 123456789128 6203-2RS/C3-10 100.00 0.455 45.500
3 123456789234 6203-2RS/EM 10.00 0.300 3.000
4 123456789340 6203-2RS/EM-50 500.00 0.300 150.000
5 123456789456 6203-2RS/EM-BULK 4750.00 0.300 1425.000
6 123456789562 6203-2LS/C3 0.00 0.000
7 123456789678 6203-2RS/C3/HTG 12.55 0.600 7.530
8 123456789784 6203-2RS/C3/15 13.00 0.600 7.800
9 123456990128 22216K 0.00 0.000

10 123452345670 22215K 0.00 0.000
11 123452355907 22215CK 209.33 0.600 125.598
12 123452365012 22215EK 209.33 0.600 125.598
13 123456990234 22215K/C4 0.00 0.000
14 123456991347 22215K/C2 0.00 0.000
15 123456990128 NJ210 0.00 0.000
16 123456990234 NJ210M 0.00 0.000
17 123456990340 NJ210P 97.52 0.600 58.512
18 123454561238 CF32 31.38 0.800 25.104
19 123454562341 CF32X 32.15 0.800 25.720
20 123454563454 CF32V 36.17 0.800 28.936
21 123453791520 LM11910 5.25 0.450 2.363
22 123453791537 LM11949 8.33 0.450 3.749
23 123453791544 LM11910/49 13.58 0.450 6.111
24 123453791551 LM11910/49 PKG 135.80 0.450 61.110
25 123458235616 PB100 25.06 0.500 12.530
26 123458247824 FB100 25.06 0.500 12.530
27 123458269017 TU100 27.49 0.500 13.745
28 123458281231 IN100 17.20 0.500 8.600
29 345679125686 1963115 150.490
30 345679237693 1545115 155.750
31 345679348702 1121115 125.000
32 345678901236 2032110 165.539
33 345679012344 2259621 171.325
34 345679023456 2371654 137.500
35 234567890457 7143921 18.85 0.650 12.250
36 234567900569 8220564 25.15 0.650 16.350
37 234567912678 6391740 27.00 0.650 17.550
38 412345678903 5230747 158.52 0.350 55.482
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PRODUCT
Examples 

Example
1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38

6 7 8 9 10
Published Distributor Price Multiplier Published Distributor Price Published OEM Price Multiplier Published OEM Invoice Price Rebate Amount

0.600 6.000 0.550 5.500
0.600 60.000 0.550 55.000
0.600 6.000 0.200 2.000 0.300
0.600 300.000 0.200 100.000 15.000
0.600 2850.000 0.200 950.000

0.000 0.000 0.000
0.600 7.530 0.550 6.903
0.600 7.800 0.550 7.150

0.000
0.000

0.600 125.598 0.550 115.132
0.600 125.598 0.550 115.132

0.000 0.000
0.000 0.000
0.000
0.000

0.600 58.512 0.550 53.636
0.800 25.104
0.800 25.720
0.800 28.936
0.550 2.888 0.350 1.838
0.550 4.582 0.350 2.916
0.550 7.469 0.350 4.753
0.550 74.690 0.350 47.530
0.500 12.530 0.600 15.036
0.500 12.530 0.600 15.036
0.500 13.745 0.600 16.494
0.500 8.600 0.600 10.320

177.047 177.047
183.235 183.235
125.000 145.000
194.752 194.752
201.559 201.559
137.500 159.500

0.750 14.135 0.700 13.192
0.750 18.865 0.700 17.608
0.750 20.250 0.700 18.900
0.500 79.260 0.450 71.334
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PRODUCT
Examples 

Example
1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38

11 12 13
Published Jobber/Reseller Price Multiplier Published Jobber/Reseller Invoice Price Published End User Price Multiplier

0.70 7.00
0.70 7.00
0.70 7.00
0.70 7.00
0.70 7.00

0.00
0.70 8.79
0.70 9.10

0.70 146.53
0.70 146.53

0.70 68.26

251.41
260.19
177.50
276.55
286.21
195.25
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PRODUCT
Examples 

Example
1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38

14 15 16 17
Published End User Invoice Price Pricing/Discount Group 1 Pricing/Discount Group 2 Description 1

100 A1 DEEP GROOVE BALL BEARING
100 A1 DEEP GROOVE BALL BEARING
110 A2 DEEP GROOVE BALL BEARING
110 A2 DEEP GROOVE BALL BEARING
110 A2 DEEP GROOVE BALL BEARING
100 A1 DEEP GROOVE BALL BEARING
150 A3 DEEP GROOVE BALL BEARING - HIGH TEMP 
180 A4 DEEP GROOVE BALL BEARING
200 ZZ SPHERICAL ROLLER BEARING
200 ZZ SPHERICAL ROLLER BEARING
200 A1 SPHERICAL ROLLER BEARING
200 A1 SPHERICAL ROLLER BEARING
200 A5 SPHERICAL ROLLER BEARING
200 A5 SPHERICAL ROLLER BEARING
260 ZZ CYLINDRICAL ROLLER BEARING
260 A6 CYLINDRICAL ROLLER BEARING
260 A1 CYLINDRICAL ROLLER BEARING
280 B1 CAM FOLLOWER
280 B1 CAM FOLLOWER
280 B2 CAM FOLLOWER
250 C1 TAPERED ROLLER BEARING
250 C1 TAPERED ROLLER BEARING
250 C1 TAPERED ROLLER BEARING SET
250 C1 TAPERED ROLLER BEARING SET 10-PACK
510 D1 BALL BEARING PILLOW BLOCK
520 D1 BALL BEARING FLANGE BLOCK
530 D1 BALL BEARING TAKE-UP BLOCK
500 D1 BALL BEARING INSERT

339.40 RBPB 3400 RB115 ROLLER BEARING PILLOW BLOCK
351.26 RBFB 3400 FB115 ROLLER BEARING FLANGE BLOCK
239.63 RBIB 3401 INS115 ROLLER BEARING INSERT
373.34 RBPB 3500 RB115E ROLLER BEARING PILLOW BLOCK
386.39 RBFB 3500 FB115E ROLLER BEARING FLANGE BLOCK
263.59 RBIB 3501 INS115E ROLLER BEARING INSERT

BQD 8200 SDS 1-1/4 QD BUSHING
BTL 8200 2517 2-7/16 TAPER-LOCK BUSHING
BST 8200 Q1 1-15/16 SPLIT TAPER BUSHING
VBB 9600 5/B75 BANDED BELT
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PRODUCT
Examples 

Example
1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38

18 19 20 21 22 23 24
Description 2 Selling Unit of Measure Units in Package Weight Unit of Weight Cubic Inches Stock Flag
BEARINGS - BALL - RADIAL - SINGLE ROW EA 1 0.1460 LB 1.13 Y
BEARINGS - BALL - RADIAL - SINGLE ROW EA 10 0.1460 LB 1.13 Y
BEARINGS - BALL - ELECTRIC MOTOR EA 1 0.1458 LB 1.13 Y
BEARINGS - BALL - ELECTRIC MOTOR EA 50 0.1458 LB 1.13 Y
BEARINGS - BALL - ELECTRIC MOTOR EA 500 0.1458 LB 1.13 Y
BEARINGS - BALL - RADIAL - SINGLE ROW EA 1 0.1460 LB 1.13 N
BEARINGS - SPECIAL LUBE EA 1 0.1462 LB 1.13 N
BEARINGS - SPECIAL BORE EA 1 0.1520 LB 1.13 Y
BEARINGS - SPHERICAL - TAPERED BORE EA 1 4.7000 LB N
BEARINGS - SPHERICAL - TAPERED BORE EA 1 3.7440 LB 37.81 N
BEARINGS - SPHERICAL - TAPERED BORE EA 1 3.7440 LB 37.81 N
BEARINGS - SPHERICAL - TAPERED BORE EA 1 3.7440 LB 37.81 Y
BEARINGS - SPHERICAL - LIMITED PRODUCTION EA 1 3.7440 LB 37.81 N
BEARINGS - SPHERICAL - LIMITED PRODUCTION EA 1 3.7440 LB 37.81 N
BEARINGS - CYLINDRICAL ROLLER EA 1 1.1510 LB 14.87 N
BEARINGS - CYLINDRICAL ROLLER EA 1 1.1600 LB 14.87 N
BEARINGS - CYLINDRICAL ROLLER EA 1 1.1310 LB 14.87 Y
BEARINGS - CAM ROLLER EA 1 1.4100 LB 26.70 Y
BEARINGS - CAM ROLLER EA 1 1.4000 LB 26.70 Y
BEARINGS - CAM ROLLER EA 1 1.4550 LB 31.81 N
BEARINGS - TAPERED ROLLER EA 1 0.1230 LB 4.76 Y
BEARINGS - TAPERED ROLLER EA 1 0.2030 LB 4.76 Y
BEARINGS - TAPERED ROLLER EA 1 0.2900 LB 4.76 Y
BEARINGS - TAPERED ROLLER EA 10 2.9100 LB 4.76 Y
BEARINGS - MOUNTED EA 1 1.7395 LB 32.77 Y
BEARINGS - MOUNTED EA 1 1.1332 LB 31.01 Y
BEARINGS - MOUNTED EA 1 1.7900 LB 52.12 Y
BEARINGS - MOUNTED EA 1 0.3500 LB 10.19 Y
MOUNTED BEARINGS EA 1 12.2100 LB Y
MOUNTED BEARINGS EA 1 10.8100 LB Y
INSERT BEARINGS EA 1 3.5000 LB Y
MOUNTED BEARINGS EA 1 12.2100 LB Y
MOUNTED BEARINGS EA 1 10.8100 LB Y
INSERT BEARINGS EA 1 3.5000 LB Y
BUSHINGS - QD EA 1 1.3000 LB Y
BUSHINGS - TAPER-LOCK EA 1 1.7100 LB Y
BUSHINGS - SPLIT TAPER EA 1 3.0500 LB Y
V-BELTS - CLASSICAL EA 1 6.3500 LB Y
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PRODUCT
Examples 

Example
1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38

25 26 27 28 29
Return Code Obsolete / New Flag New/Superseded Catalog or Item Number New/Superseded UPC Number Estimated Lead Time
Y 1
Y 1
Y 1
Y 1
Y 7
Y O 6203-2RS/C3 123456789012
N 45
Y 60
N O
N O 22215EK 123452365012
Y O 22215EK 123452365012
Y 7
Y 60
N 60
N O NJ210P 123456990340
N 90
Y 7
Y 7
Y 7
Y 30
Y 1
Y 1
Y 1
Y 1
Y 1
Y 1
Y 1
Y 1
Y R RB115E 345678901236
Y R FB115E 345679012344
Y R INS115E 345679023456
Y N RB115 345679125686 14
Y N FB115 345679237693 14
Y N INS115 345679348702 14
Y U 234561230679 7
Y U 234561230785 7
Y U 234561230891 7
Y I B75-5 1

© 1999-2010.  Power Transmission Distributors Association and Bearing Specialists Association. Page 8 of 13
50



PRODUCT
Examples 

Example
1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38

30 31 32 33 34 35
Substitute Catalog or Item Number Substitute UPC Number Distributor Part Number MSDS ID Number Effective Date Expiration Date
6203-2RS/EM 123456789234 11/01/2005 12/31/2006

11/01/2005 12/31/2006
11/01/2005 12/31/2006
11/01/2005 12/31/2006
11/01/2005 12/31/2006

11/01/2005 12/31/2006
11/01/2005 12/31/2006

11/01/2005 12/31/2006
11/01/2005 12/31/2006
11/01/2005 12/31/2006
11/01/2005 12/31/2006
11/01/2005 12/31/2006
11/01/2005 12/31/2006
11/01/2005 12/31/2006
11/01/2005 12/31/2006

CF32X 123454562341 11/01/2005 12/31/2006
11/01/2005 12/31/2006
11/01/2005 12/31/2006
11/01/2005 12/31/2006
11/01/2005 12/31/2006
11/01/2005 12/31/2006
11/01/2005 12/31/2006
11/01/2005 12/31/2006
11/01/2005 12/31/2006
11/01/2005 12/31/2006
11/01/2005 12/31/2006
01/01/2005
01/01/2005
01/01/2005
01/01/2005
01/01/2005
01/01/2005
01/01/2005
01/01/2005
01/01/2005
01/01/2005
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PRODUCT
Examples 

Example
1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38

36 37 38 39 40 41 42 43
Special Pricing Flag Brand Next Higher Package UNSPSC User-Defined Field User-Defined Field User-Defined Field User-Defined Field

GBH 10
GBH
GBH 50
GBH 500
GBH
GBH
GBH

Y GBH
GBH
GBH
GBH
GBH
GBH
GBH
GBH
GBH
GBH
Jones
Jones

Y Jones
Canton
Canton
Canton 10
Canton
GBH
GBH
GBH
GBH
SFZ
SFZ
SFZ
SFZ
SFZ
SFZ
SFZ
SFZ
SFZ
SFZ

© 1999-2010.  Power Transmission Distributors Association and Bearing Specialists Association. Page 10 of 13
52



PRODUCT
Examples 

Example
1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38

44 45 46 47 48 49 50 51 52
User-Defined Field Dimension Unit of Measure Length Width Height User-Defined Field User-Defined Field User-Defined Field User-Defined Field

IN 1.50 1.50 0.50
IN 1.50 1.50 0.50
IN 1.50 1.50 0.50
IN 1.50 1.50 0.50
IN 1.50 1.50 0.50
IN 1.50 1.50 0.50
IN 1.50 1.50 0.50
IN 1.50 1.50 0.50

IN 5.50 5.50 1.25
IN 5.50 5.50 1.25
IN 5.50 5.50 1.25
IN 5.50 5.50 1.25
IN 5.50 5.50 1.25
IN 3.70 1.06 3.78
IN 3.70 1.06 3.78
IN 3.70 1.06 3.78
IN 3.39 2.33 3.39
IN 3.39 2.33 3.39
IN 3.56 2.51 3.56
IN 2.25 0.94 2.25
IN 2.25 0.94 2.25
IN 2.25 0.94 2.25
IN 2.25 0.94 2.25
IN 3.00 1.94 5.63
IN 3.88 2.06 3.88
IN 4.75 2.31 4.75
IN 2.50 1.63 2.50
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PRODUCT
Examples 

Example
1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38

53 54 55 56 57 58 59
User-Defined Field User-Defined Field User-Defined Field User-Defined Field User-Defined Field User-Defined Field User-Defined Field
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PRODUCT
Examples 

Example
1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38

60 61 62 63 64 65 66 67 68
Minimum Order Quantity POR Flag Conditional Price Multiplier Conditional Invoice Price Country of Country of Country of Country of Country of 

250
0.400 5.200

Y
Y

10

0.600 21.702

IT CA NO
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“Instead of having one person dedicated to dealing with 
price files 15 days each month and chasing outdated 
price books and the rest, we’ve been able to shift that 
talent to customer service, where that staff member now 
generates revenue.” 
 
 Steve Philpott, President 
 Bearing Belt Chain Co., Inc. 
 (Las Vegas, Nev.) 

 
 

PPIF DISTRIBUTOR USER FORM 
 
 
Users of the Product & Price Information Format (PPIF) will be included in communications to promote 
adoption by distributors, manufacturers, industrial distribution trade associations and distribution software 
providers. 
 
We currently accept product and price updates in the PPIF format and commit to comply with all format 
use requirements.  Please add us to the list of users. 
 
Please complete the following: 
 

Name  

Title  

Company  

Address  

  

Phone  E-mail  

Association  

Distributor Management Software Used  
 
 
 
 
 

Please fax this completed form to +1.312.516.2101. 
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SAMPLE LETTER FROM DISTRIBUTORS TO MANUFACTURERS 

DATE 
 
NAME 
TITLE 
COMPANY 
ADDRESS 
CITY, STATE ZIP 
COUNTRY 
 
RE:  PPIF: One Way to More Efficient Product & Price Updates 
 
Dear INFORMAL: 
 
I am writing to request that your company provide all price and product updates in the standardized 
Product & Price Information Format (PPIF) endorsed by [ASSOCIATION]. 
 
The PPIF reduces transaction costs, increases channel efficiency and benefits our companies directly: 
 
• Greater savings: The PPIF allows you to provide updates to all distributors and OEMs in a single 

format, dramatically reducing your costs to create and transmit these files.  Because the PPIF is an 
ASCII format, no investment in specialized software is required. 

 
• Improved accuracy: The PPIF eliminates the need for our company to manually re-key vendor data, 

ensuring information in our system is correct.   
 
• Faster updates: The PPIF reduces the time for us to upload and implement updates.  Getting updated 

pricing and obsolete/substitute information into our system more quickly minimizes product returns, 
and debit and credit processing errors. 

 
More information about the PPIF is available at www.ptda.org/PPIF, including endorsing distributors and 
manufacturers, free downloads of the format, and documents to simplify implementation and use.   
 
We also request that you designate a single contact at your company who can answer update questions 
and has authority to address any compliance issues.  The key contact within our company for product and 
price updates is NAME.  Please contact HIM/HER at PHONE or E-MAIL with questions regarding our 
request or the PPIF format. 
 
Thank you for your commitment to working with us to reduce transaction costs and improve efficiency 
for both our companies and our joint customers. 
 
Sincerely, 
 
 
 
NAME 
President 
COMPANY 
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SAMPLE LETTER FROM DISTRIBUTORS TO SOFTWARE PROVIDERS 

DATE 
 
 
NAME 
TITLE 
COMPANY 
ADDRESS 
CITY, STATE ZIP 
COUNTRY 
 
RE:  PPIF: One Way to More Efficient Product & Price Updates 
 
Dear INFORMAL: 
 
As a user of your distribution management program, I am writing to request that you incorporate version 
2.1 of the standardized Product & Price Information Format (PPIF) in your next software update.   
 
The PPIF has improved efficiency in the industrial distribution channel by: 
 
• Allowing manufacturers to supply and distributors to receive product and price updates in a single, 

standardized ASCII-tab delimited format. 
• Improving operating efficiencies and accuracy by eliminating manual re-keying.   
• Reducing transaction costs, administrative costs and time to transmit and upload updates. 
 
Over 95 manufacturers and almost 90 distributors in PTDA already have endorsed the PPIF, as have  the 
Bearing Specialists Association, the American Bearing Manufacturers Association, Association for High 
Technology Distribution, FPDA Motion + Control Network, NAHAD—The Association for Hose and 
Accessories Distribution, and the National Fluid Power Association.  A complete list of endorsers is 
available at www.ptda.org/PPIF. 
 
In today’s business environment, reducing transaction costs and increasing channel efficiency is critical.  
Incorporating the PPIF in your software will make it even easier for distributors to upload and implement 
updates in the standardized format. 
 
The format is available for free download at www.ptda.org/PPIFdownloads.  Questions may be directed 
PTDA (+1.312.516.2100; ptda@ptda.org) or BSA (+1.630.858.3838; info@bsahome.org). 
 
Thank you for your commitment to working with your customers to take cost out of the distribution 
channel. 
 
Sincerely, 
 
 
 
NAME 
President 
COMPANY 
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“Adopting the PPIF has made it easy for us to create and 
transmit regular updates—and easy for our customers to 
process them.  Our distributors know what products have 
been obsoleted and what replacement parts are 
available, eliminating errors and avoiding thousands of 
dollars of potential missed opportunities each month.” 
 

Randy Bowen 
VP Distributor Relations 

SKF Service Division

 
 

PPIF MANUFACTURER USER FORM 
 
 
Users of the Product & Price Information Format (PPIF) will be included in communications to promote 
adoption by distributors, manufacturers, industrial distribution trade associations and distribution software 
providers. 
 
 
Please complete the following: 
 

Name  

Title  

Company  

Address  

  

Phone  E-mail  

Association  
 
 
Please check the appropriate box(es): 
 

 We currently provide product and price updates in the PPIF format and commit to comply with all 
format use requirements.  Please add us to the list of users. 

 
 We plan to implement the PPIF and expect to begin providing product and price updates in this 

format with the following update:   (month/year). 
 
 
 
 
 

Please fax this completed form to +1.312.516.2101. 
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SAMPLE LETTER FROM MANUFACTURERS TO DISTRIBUTORS 

DATE 
 
 
NAME 
TITLE 
COMPANY 
ADDRESS 
CITY, STATE ZIP 
COUNTRY 
 
RE:  PPIF: One Way to More Efficient Product & Price Updates 
 
Dear INFORMAL: 
 
I am writing to inform you that beginning with our DATE update, our company will provide all price and 
product updates in the standardized Product & Price Information Format (PPIF) endorsed by 
[ASSOCIATION]. 
 
The PPIF reduces transaction costs, increases channel efficiency and benefits your company directly: 
 
• Greater savings: The PPIF allows you to receive product and price updates from all suppliers in a 

single format, dramatically reducing your cost to process and upload these files.  Because the PPIF is 
an ASCII format, no investment in specialized software is required. 

• Improved accuracy: The PPIF eliminates the need for manually re-keying of vendor data.   
• Faster updates: The PPIF reduces the time to upload and implement updates.  Getting updated pricing 

and obsolete/substitute information into your system more quickly minimizes product returns, and 
debit and credit processing errors. 

 
More information about the PPIF is available at www.ptda.org/PPIF, including endorsing manufacturers, 
free downloads of the format and supplemental documents, and frequently-asked questions.   
 
To maintain the integrity of the standard, we provide compliant files in ASCII-tab format that include all 
data fields.  We request your help in protecting the standard by: 
 
• Accepting PPIF-compliant files rather than requesting custom updates. 
• Working with us to extract only the information you need from the update file and, if needed, convert 

data to Microsoft Excel® or Access® to upload to your system or for direct reference. 
• Reporting any compliance issues with our updates to be addressed. 
 
The key contact within our company for product and price updates is NAME.  Please contact HIM/HER 
at PHONE or E-MAIL with questions regarding the PPIF format or our next update. 
 
Thank you for your commitment to working with us to reduce transaction costs and improve efficiency 
for both our companies and our joint customers. 
 
Sincerely, 
 
 
 
NAME 
President 
COMPANY 
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PPIF:                to Updates
• Product & Price Information Format 

(PPIF)
• Objective: Reduce transaction costs/ 

increase channel efficiency
• Tactic: 

– Address patchwork of vendor formats 
– Eliminate need for distributors to manually 

re-key updates

PPIF:                to Updates
• Single-format, single-program system 

for e-transmission of manufacturer price 
& product updates

• Suitable for use by distributors & OEMs
• ASCII format 

– No software investment required
– Transmission via mail, e-mail or Internet

PPIF:                to Updates
• One way to greater savings: 

– Reduces costs to create, transmit & upload 
updates  

• One way to improved accuracy: 
– Eliminates re-keying, ensuring accuracy & 

reducing time to upload/implement updates
• One way to enhanced efficiency: 

– Manufacturers supply/ distributors receive updates 
in single format, reducing transaction costs & 
improving channel efficiency

• Resources to clarify requirements/ 
simplify implementation and use:
– How to create, transmit and use PPIF files
– Compliance checklist
– Examples of acceptable field use
– Frequently-asked questions
– Converting PPIF data to Excel or Access

• Available at www.ptda.org or own 
association web site

PPIF:                to Updates PPIF:                to Updates
• Wrong way: Even minor modifications 

defeat standard’s purpose
• Right way:

– Request/provide updates in standard PPIF 
format

– Work with business partner to extract 
needed data / convert format if necessary

– Report compliance issues to partner to 
address
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• Inform current suppliers expect price 
updates in PPIF format

• Make PPIF a key criteria when evaluating 
prospective new lines

• Encourage distributor software providers 
to incorporate PPIF in next release

• Report use to association for recognition / 
promotion

PPIF: Distributor Action Items
• Implement PPIF for price updates
• Promote PPIF adoption to distributors

– Designate PPIF contact within company
– Include in all update letters
– Communicate to manufacturer reps/ 

CSRs/regional managers
– Phase out non-PPIF updates

• Report use to association for recognition / 
promotion

PPIF: Manufacturer Action Items
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